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September 2018 

The following guide can be used to download licensure data the Florida Department of 
Health’s website: http://www.flhealthsource.gov/. The Licensure Data Download 
provides the practitioner name, license information, mailing address, and email address 
for health care practitioners and establishments licensed in Florida. 

The Licensure Data is provided in text format which can be easily opened in Microsoft 
Excel or other spreadsheet program. The following guide provides basic instructions on 
how to import and manipulate the data in Excel. There are many online tutorials about 
spreadsheets and how to use Excel. If you are unfamiliar with spreadsheets or Excel, it 
is strongly recommended you seek basic instruction in order to fully utilize the data. 
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I. Licensure Data Download Instructions 

To locate the Licensure Data Download file, first navigate to our website located at 
http://www.flhealthsource.gov/ 

Click on Consumer Services on the top menu bar then Public Data Portal from the 
dropdown list: 

http://www.flhealthsource.gov/
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The web site allows you to download a text file that can be saved and imported into 
Microsoft Excel, Microsoft Access, or other database software. Once the data has been 
imported you can manipulate the data as necessary. 

1. Select the Practitioner Data Portal
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2. Go to the blue navigation box on the left side of the screen.  Click the down arrow
to the right of Download Data.
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3. Select the License Data Download link.

The License Data File Download page will be displayed. The page provides a list of 
data fields that are included in the download data. 

4. Select the option for either Select Profession or All Professions
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I. Licensure Data Download Instructions 
Option A:  Selecting a single profession 

1. After you choose the ‘Select a Profession’ radio button, the web page will refresh.

Select a profession from the dropdown list:
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When you have selected the profession you need, the page will refresh. Select the 
Status to the right. (The status box will provide you with the size of the text file you 
have selected and the date it was last updated). 

2. Select the status.  In most cases, Currently Licensed is appropiate.  All
Statuses will include statuses such as ‘Null and Void’, ‘Deceased’, etc.
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3. The page will refresh again.  Scroll down and note a new link has appeared
beneath the box for profession and status. Click the link to download the
information into a text file.
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4. When you click on the Licensure Data Download link, a text delimited filed will be
displayed in a new browser window. On the menu bar, click on File -> Save As
and save the file to your hard drive. Or In Internet Explorer, click on the Page
icon -> Save As and save the file. Save the file to a location you can easily find
later when you are ready to import the data into your Microsoft Excel or other
spreadsheet program.
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I. Licensure Data Download Instructions 
Option B: Selecting “All Professions” 

‘All Professions’ will display the following page with instructions on downloading the text 
file containing all professions. 

Select ‘Currently Licensed’ or ‘All Statuses’ and follow the prompts as indicated. 
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II. Importing Your Saved Data File into MS Excel

To Import into Excel: 

1) Open the Microsoft Excel application.

2) Select "File” then “Open" from menu bar at upper left.

3) At the bottom of the dialog box change "Files of type" at bottom of box to "Text
Files”. 
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4) Navigate to the text file you saved and Open it. The "Text Import Wizard" box
should appear. For original data type, select ‘Delimited’ and click Next.
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5) Uncheck ‘Tab’ and check ‘Other’. In the box next to ‘Other’, enter the "|"
(pipe character) by holding down the shift key and then the “\” (back-slash)  key 
just above the "ENTER" key, change the Text qualifier to ‘{none}’, then click the 
"Finish" button. 

The Data now is filled into spreadsheet 
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6) Next, save the data in an Excel format. If you click on Save, you will get a
warning message about losing your spreadsheet format. To keep your work (new
features), choose ‘No’.

7) Select your desired file type. The example below is saved as an .xls (Excel 97-
2003) format. Rename the document if desired in "File Name" box and then click
"Save" button.

IMPORTANT:  The nursing profession contains more than 200,000 records. 
Excel 2003 or earlier has a 65,000 row limitation. To overcome this limitation, use 
Excel 2007 or newer or import the data into an MS Access database. 
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III. Manipulating the Report Layout in MS Excel

Expanding the columns 

When you open the file, you may see some of the columns are compressed and have 
cut off much of the information you need. Click on the gray box in the upper left 
hand corner of the Excel spreadsheet to highlight the entire spreadsheet. 

1. Highlight the
spreadsheet by 
clicking here. 

2. Place cursor between
columns and double click 
to expand columns. 

Place your cursor in-between the first and second columns until your cursor 
becomes a vertical line with an arrow on either side.  Double click and all columns will 
expand to the length of the longest piece of information in that column. 

Freezing Panes 

It is convenient to keep the column names visible at the top of the spreadsheet as you 
are scrolling down so you do not have to scroll up to see the column names.  You want 
to “freeze panes”. This can be done to keep any amount of columns on the left of the 
screen or any amount of rows on the top of the screen from moving while you are 
scrolling. 

1. Highlight the cell that is immediately below the rows you want to keep on the
top of the screen and immediately to the right of the columns you want to keep
on the left of the screen.

In the example below we want to keep the top row on the screen. Place the cursor in 
cell A2. 



Florida Department of Health 
Division Of Medical Quality Assurance 
System Support Services 

Page 15 
Licensure Data Download Guide Last updated: 

September 13th, 2018 

2. Excel 2007 and earlier: Open the Window menu on the menu bar and select Freeze
Panes.

1. Select cell
A2. 

2. Select Freeze Panes from
the Window menu 

Excel 2010: Freeze Panes is located on the View ribbon. Note: Excel 2010 can also 
freeze the top row without your having to click on cell A2 first, but be careful! 
Freeze top row freezes the top visible row.  Your headers must be visible for “freeze 
top row” to be useful. If you inadvertently freeze a lower row, simply choose 
“unfreeze rows” and try again. 
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Sorting 

Sorting makes it easier to find relevant information by listing the information in a certain 
order. 

1. In Excel 2007 and earlier: If the report is not sorted how you would like it to be, just
highlight the column you want to sort by, click on Data in the menu and click Sort.

In Excel 2010, sort is located on the Data ribbon. 
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2. A menu will pop up saying Excel found data next to the column you selected.

3. Each row of the spreadsheet contains data associated with a single record, so you
want to keep all the row data together while sorting.  To do this, indicate that you
want to expand your selection and click the Sort button.  If you do not expand the
selection, the highlighted column will be sorted and the other columns will not be
sorted, resulting in one record’s data showing in a different record. Choosing to
expand the selection will keep all the rows together when the data is sorted.

4. A criteria box will then appear and ask you how you would like to sort your data.
Indicate how you would like to sort your information.  Make sure the option is
checked that indicates you have a header row (column names), and then click OK.

Excel 2007 and earlier: 
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Excel 2010: 

5. Your list is now sorted.
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Deleting Columns 

You may want to delete the columns you do not want in your finished report. 

Highlight the column you want to delete by clicking on the letter for that column at the 
top of the screen. Right click anywhere in the column and select delete. 
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Formatting Cells and Columns with “Wrap Text” 

Our final formatting tip can help when you want to reduce “empty space” in your reports. 
This can help your reports look better on the screen, but it’s most important when 
printing. When printing all columns on a single width of paper, the combination of 
deleting unwanted columns and reducing “empty space” can prevent your report from 
being so reduced in size on paper that it is unreadable. 

Here we start with unformatted columns with unused or empty spaces: 

We can save column space by word-wrapping the column title “Board-Action-Indicator.” 
First, select the cell with the long title (in this case, cell G1.) Then, either right-click and 
choose “Format cells,” or use the format cells command on the Home ribbon: 
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Choose the Alignment tab and check the “word wrap” checkbox: 

Now you can mouse over the right border of that cell and reduce the column width. At 
first, the title looks cut off: 

Place your mouse at the bottom of row 1 at the far left of the spreadsheet and double- 
click.  The row expands to fit all the text: 

You can repeat the above steps for as many header columns as you want to shrink: 
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Last, there are times when it is not the header, but one long data element that is 
stretching the column to make a lot of empty space on the other rows: 

Format cells as you did before, only select the entire column first: 



Florida Department of Health 
Division Of Medical Quality Assurance 
System Support Services 

Page 23 
Licensure Data Download Guide Last updated: 

September 13th, 2018 

Now, you can adjust the column width: 

The Deerwood address is cut off now, so select the entire spreadsheet as you did 
before, then double-click under row 1 to expand the rows to fit all the data: 

1. Highlight the
spreadsheet by 
clicking here. 

2. Place cursor between
rows and double click to 
expand rows. 
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Now, you have a compact Mailing-Address-line2 column, but all the information in the 
long Deerwood entry still shows: 

By using “wrap text” on heading cells and columns with long data, you can reduce 
empty space and have a finished report with a similar format to the finished example 
below: 
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A. Descriptions of Licensure Data Fields

Column Name Description Data Type 
Profession Code Code that identifies profession, unique key of the profession Numeric 
Profession Name Name of the profession. Char 
License ID System defined numeric used to identify a license through the 

system.
Numeric 

Expire Date Date License expired Char 
Original Date Date License was first issued Char 

Rank Code 
Unique identifier of the license rank associated with the 
license, if applicable. Char 

License Number / CNA 
Certificate Number 

Current license number or CNA current certificate number. 
License number refers primarily to the number printed on the 
wall license. This number will only change if the license is 
revoked and reissued for some reason. 
For duplicate licenses, the number will not change.  Certificate 
number refers to CNA's current certificate number. 
CNAs may have mutiple certificate numbers as a result of a request 
for a replacement of a certificate. Note: Only the most 
current certificate number is provided.

Char 

Status effective date Effective date of statuses Char 
Board Action Indicator Yes/No indicator. "Y" = Action taken or complaint upheld 

against licensee.
Char 

License Status 
Description

Status of License, description to be used on certificates etc Char 

Last Name Last Name Char 
First Name First Name Char 
Middle Initial Middle Initial Char 
Name Suffix Licensee's suffix name (i.e. JR, III, IV etc) Char 
Business Name Organization's Business Name Char 
License Active Status 
Description

Active Status Description, the description or interpretation of 
this status

Char 

County County name associated with mailing address. Char 
Mailing Address Line1 First Line of Mailing Address Char 
Mailing Address Line2 If applicable, Second line of Address Char 
Mailing Address City Mailing address City Name Char 
Mailing Address State Mailing address State code Char 
Mailing Address Zipcode Mailing address zip + 4 postcode Char 

Mailing Address Area 
Code

3 digit area code Char 

Mailing Address Phone 
Number

7 digit phone number Char 

Mailing Address Phone 
Extension

phone extension (max 4 digits) Char 

Prescribing Indicator 

In accordance with s. 456.44, Florida Statutes, a physician licensed 
under chapter 458, chapter 459, chapter 461, or chapter 466, a 
physician assistant licensed under chapter 458 or chapter 459, or an 
advanced practice registered nurse certified under part I of chapter 
464 who prescribes any controlled substance, listed in Schedule II, 
Schedule III, or Schedule IV as defined in s. 893.03, for the treatment 
of chronic nonmalignant pain, must designate himself or herself as a 
controlled substance prescribing practitioner on his or her practitioner 
profile. 

 Char 

Dispensing Indicator Practitioner dispenses medication at this location. Char 
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B. Information Pertaining to the Licensure Data Download 

General Information Concerning Data Downloads 

Under Chapter 119, Florida Statutes, the Department of Health (DOH) is required to make available for inspection and 
copying any public record regardless of physical format, which is not otherwise exempted from public access by general law. 
The department fulfills this requirement by providing copies of electronic records to the public. 

Section 119.01(b), F.S., requires only that the agency provide electronic data in some common format such as, but not limited 
to, the American Standard Code for Information Interchange (ASCII) text format. Therefore, the download files provided on 
this page are formatted as ASCII text, pipe delimited. 

Financial information, medical information, school transcripts, examination questions, answers, papers, grades and grading 
keys, which are confidential and exempt from s. 119.07(1), F.S.,. will be withheld pursuant to Chapter 455.232, Florida 
Statutes. Social Security numbers will also be redacted pursuant to 42 U.S.C. 405(c)(2)(C)(viii)(I). 

About Profession Data File Downloads 

• Data files are updated on Saturday of each week. Please note: Although data is scheduled to be refreshed on a
weekly basis, system maintenance may periodically delay this process.

• All phone numbers listed in the profession data files are not required to be given by the health care
professional.  The Florida Department of Health does not maintain phone numbers in daily business practice.

• If you use Microsoft Excel to open your file, it is limited to 65,536 rows per spreadsheet.

• The Department does not offer technical support during or after the download process. The purpose of the download
site is to provide an individual with data that can be used in spreadsheet, word processing, or database programs.
The Department assumes that users have the necessary knowledge for downloading a file into a spreadsheet and/or
other software.
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C. Professions Codes and Descriptions

Profession Code Profession Name 

2002 Apprentice Optician 

1403 Approved Massage School 

1001 Athletic Trainer 

3002 Audiologist 

3004 Audiology Assistant 

503 Certified Chiropractic Physician's Assistant 

1511 Certified Foreign School 

5401 Certified Master Social Worker 

4401 Certified Nursing Assistant 

2105 Certified Pod X-Ray Assistant 

5702 Certified Respiratory Therapist 

501 Chiropractic Physician 

6604 Clinical Laboratories-Reference Only 

6601 Clinical Laboratory Personnel 

6602 Clinical Laboratory Trainee 

6603 Clinical Laboratory Training Program 

2203 Consultant Pharmacist 

3201 Council of Midwifery 

701 Dental 

702 Dental Hygienist 

704 Dental Laboratory 

703 Dental Radiographer 

706 Dental Teaching Permits 

6001 Diagnostic Radiological Physicist 

6101 Dietetics/Nutritionist 

6501 Electrologist 

6502 Electrolysis Facility 

7401 Health Care Clinic Registration 

3601 Hearing Aid Specialist 

3801 Licensed Acupuncturist 

5201 Licensed Clinical Social Worker 

5202 Licensed Marriage and Family Therapist 

5203 Licensed Mental Health Counselor 

1702 Licensed Practical Nurse 

1506 Limited License Medical Doctor 

2703 Limited License Psychologist 

1402 Massage Establishment 

1401 Massage Therapist 

1711 Advanced Practice Registered Nurse
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1501 Medical Doctor 

1507 Medical Doctor Area Critical Need 

1505 Medical Doctor Limited to Cleveland Clinic 

1504 Medical Doctor Limited to Mayo Clinic 

1503 Medical Doctor Public Health Certificate 

1502 Medical Doctor Public Psychiatry Certificate 

1513 Medical Doctor Restricted 

1509 Medical Doctor Visiting Faculty Certificate 

1508 Medical Faculty Certificate 

6004 Medical Health Physicist 

6003 Medical Nuclear Radiological Physicist 

6006 Medical Physicist Continuing Education Course 

6007 Medical Physicist In Training 

3203 Midwifery CE Providers 

1601 Naturopathic Physician 

2204 Nuclear Pharmacist 

801 Nursing Home Administrator 

6102 Nutrition Counselor 

5601 Occupational Therapist 

5602 Occupational Therapy Assistant 

1514 Office Surgery Registration 

2003 Optical Establishment Permit 

2001 Optician 

1801 Optometrist 

1802 Optometry Branch Office 

3104 Orthotic Fitter 

3105 Orthotic Fitter Assistant 

3103 Orthotist 

1904 Osteopath Faculty Certificate 

1903 Osteopathic Limited License 

1901 Osteopathic Physician 

3106 Pedorthist 

2201 Pharmacist 

2202 Pharmacist Intern 

2205 Pharmacy 

5501 Physical Therapist 

5502 Physical Therapist Assistant 

1512 Physician Assistant 

2101 Podiatric Physician 

2102 PODIATRIC RESIDENCY PROGRAM 

3101 Prosthestist-Orthotist 
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3102 Prosthetist 

3006 Provisional Audiologist 

5204 Provisional Clinical Social Worker Licensee 

5205 Provisional Marriage and Family Therapist Licensee 

5206 Provisional Mental health Counselor Licensee 

2702 Provisional Psychologist 

3005 Provisional Speech-Language Pathologist 

2701 Psychologist 

502 Registered Chiropractic Assistant 

5207 Registered Clinical Social Worker Intern 

5208 Registered Marriage and Family Therapist Intern 

5209 Registered Mental Health Counselor Intern 

1701 Registered Nurse 

5701 Registered Respiratory Therapist 

5706 Registered Student Exemption 

5703 Respiratory Care Practitioner by Exam 

5704 Respiratory Care Practitioner Critical Care 

5705 Respiratory Care Practitioner Non-Critical Care 

4101 School Psychologist 

3003 Speech_Language Pathology Assistant . 

3001 Speech-Language Pathologist 

3202 Temp Midwife 

6002 Therapeutic Radiological Physicist 

1510 Unlicensed Medical Doctor 

1902 Unlicensed Osteo Registration 




